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1. Graphical users interface

1.1 Introduction

In this document the main features of the IRTPRO graphical users interface (GUI) are



summarized.

When IRTPRO is launched (typically by clicking on the IRTPRO icon on the computer
desktop), a page is opened containing clickable links to recently used files, the Import Data
menu, online help documentation and to gain access to the SSI website. At this stage, the
main menu bar displays the File, View and Help options.

T

File View Help
ST IEETIERD

IRTIPRC

Flexible Professional ltem R Theory Modeling for Patient-Reported Outcomes

O Start New Project & IRTPRO Guide

=~ Import Data @ Connect to SSI website
@ Online help for IRTPRO

| Recently Opened Files
SelfMon4.ssig [C:\IRTPRO Examples\By Dataset\SelfMonitoring\]
Isat6ScoreTable.irtpro [C:\IRTPRO Examples\By Dataset\LSAT6\]
Eysenck87-itemsl 57.ssig [C:\IRTPRO Examples\By Dataset\Impulsivity\]
AACL3 21Items.ssig [C:\IRTPRO Examples\By Dataset\AACL\]
simul5.ssig [C:\IRTPRO Examples\By Dataset\Simulated\]

1.2 Opening an IRTPRO data (ssig) file

By clicking the File button, the drop-down menu shown below is activated.



View Help

Mew... Ctrl+N
Open... Ctrl+0O

Import...
Print Setup...

1 Asthma34.ssig

2 Eysenck87-itemsl_57.2PL-9items-irthtm
3 Eysenck87-itemsl_57.ssig

4 SelfMond.irtpro

5 SelfMond.ssig

Close
Exit

By selecting the Open option, a standard Open dialog box is displayed.

Look in:

Recent Places

Desktop

Libraries

| Speliing ~ @02

Mame
| Spellin

g.551g

<|

11

File name:

Files oftype:

v

Date modified
5/2/2011 11:45 AM

Spelling.ssig

|1RTPRG Data File i:ﬁ l

IRTPRO Command File (*.itpro
IRTPRO Data File (* ssig)

Fixed Format Data (*fixed)
IRTPRO HTML Qutput File (*htm)
IRTPRO Plot Files (*.irtplof)

All Files (**)

There are five main file types that IRTPRO can open, these being:

o An IRTPRO command (syntax) file with extension .irtpro

@)

O

An IRTPRO data file with extension .ssig

Fixed format data with extension .fixed

An IRTPRO HTML output file with extension .htm
An IRTPRO plot file with extension .irtplot



A file with extension .ssig refers to an IRTPRO data file and is typically created by importing
data from a statistical software package such as SPSS or SAS or a spreadsheet program such
as Excel.

1.3 Spreadsheet main menu bar

IRTPRO data files are displayed in spreadsheet form.

IRTPRO - [Spelling.ssig
W | File Edit Data Manipulate Graphics Analysis View Window Help -] =] x]
IEELIEEEIERT

InFidtility Panoramic | Succumb | Girder I Gender

=

LDUD'H-.IU’!U‘IJH-LAJI\JI
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o oo oo oo o oo
0o o0 o oo oo oo
022 0o oo oo o
i R e e e e e e

=}

Ready ]

Once a file of type .ssig is opened, the main menu bar displays several options. For example,
by clicking the Analysis button the drop-down menu shown below is obtained.

IRTPRO - [Spelling.ssig

[#] File Edit Data Manipulate Graphics | Analysis| View Window Help

IEEEIEEEER D Traditional Summed-Score Statistics...
Infidility P anoramic | Succumb I Unidimensional IRT...

Multidimensional IRT...

IRT Scoring...

Advanced Options...
v Show Progress Box

oo oo oo oo o
2 oo o oo oo oo
oo oo oo oo oo

There are four main types of analyses, namely:
o Traditional summed-score statistics

o Unidimensional IRT



o Multidimensional IRT
o IRT scoring

o IRT simulation

There are two additional items on the Analysis list, these being Advanced Options... (see
Section 1.9) and Show Progress Box. By selecting the Show Progress Box option (the
default), various results of the analysis are displayed, enabling the user to visually determine
if the analysis is still running and what progress has been made.

The image below is a screen shot of the progress box for an analysis that is partially
completed.

IRTPRO X

IRTFRO: Test 1

Par=ing config

Record 0 ~ 586

Beginning IRTFRO computations
Initializing integration methods. . done.
Initializing segment structures. .. done.
Initializing item structures... done.
Initializing data structures... done.

27 21.9162 63709.7570

1.4 Test Tabs

Regardless of the type of analysis specified, several tests (analyses) may be created using the
same IRTPRO dataset. To insert a new test, right-click on the right-hand side of a current test
to insert a new test tab.



Unidimensional Analysis ]

Data File: I C:\IRTPRO Examples'By Dataset\speling\Spelling. ssig J Read File |

Test1 |

Insert Test...
Celete Test odels l| Scoring l| Simulation l

Rename

Manage Test...

Comments:
2PL model. Grouping is Gender

Options... | oK I Cancel Run

By right-clicking on a test tab, the test may be renamed or deleted. The sequence of steps to
rename the first test tab to 2PL is shown below.

Select the Rename option Enter 2PL

Data File: I C:\IRTPRO Examples\By Dataset'\Spelling’,

Data File: I C:\IRTPRO Examples\By Datazet\Speling\Speling.ssig

| 2PL | Test2 |
Test] |
Insert Test... l Description | Group | ems || Models || Scoring
O Delete Test s || Scoring || Simuiation | Tile:
Rename Spelling Test - 4 tems
Manage Test...
Comments:

1.5 The Description, Group and Iltems tabs

When a traditional statistics, unidimensional, or multidimensional analysis is requested via
the Analysis option, the first three tabs displayed in the corresponding analysis window are



Description, Group and Items. Each of the Description, Group and Items dialogs will be
briefly discussed in Sections 1.5.1 to 1.5.3.

1.5.1 The Description tab

F ™

Data File: | C:\IRTPRO Examples\By Dataset\PISA MathBook 1\PISAMathBook 1USUK. ssig J Read file |

Tradtional |"TRT | Rasch | THT |

Description IGroup || ltems || Madels l|5coring l|5imulatior1|

Title:
2-group IRT Analysis (GPC model for polytomous tems)

Comments:
Midture of 2PL and General Partial Credit Models

Options... | oK I Cancel Run

The Description tab has two text boxes that are used to enter a title (description) and optional
comments for each test tab. Shown above is the Description tab for a Unidimensional
Analysis based on the test named IRT.

1.5.2 The Group tab

The Group tab allows one to select one or more grouping variable(s) from the List of
Variables: text box. In the dialog shown below, the variable Country was selected as the
grouping variable. By default, the first group is selected as the reference group. However, the
Group dialog box allows the user to select any other group as the reference.



F ™

Data File: | C:\IRTPRO Examples'By Dataset\PISA MathBook 1\PISAMathBook 1USUK, ssig J Read File |

Tradtional  IRT 'Haschl TRT |

| Deseription | Group I ltems || Modelsl|5coring l|5imulatior1|

List of variables: Group: > |

Cubel Country 4+
Cubed

Cubed +
Fams 1 add > |

Fams4

Walking1

Walking3

Apples1

Apples2

Apples3 [Ref] Name | Country

Continert Gl 1
Grow1
Grow3 C1G2 2
Grow2

Courtry

Options... oK I Cancel Run

1.5.3 The Items tab

The Items tab dialog box for a traditional statistics or unidimensional IRT analysis is shown
below. Items can be selected for each group from the List of variables: column and adding it
to the Items: column.

In most practical applications, a multiple group analysis is based on the selection of the same
set of items for each group. If this situation applies, the user selects the items from the List of
variables: for the first group and then clicks on the Apply to all groups button to make the
same selection for all groups.



,

Data File: | C:\IRTPRO Examples\By Dataset\PISA MathBook 1\PI5AMathBook 1USUK. ssig J Read file |

Tradtional  IRT 'Flaschl TRT |

|D&Bcrpt|on||GroLp| ftems 'Modelsl|500mgl|wat'°"|
Country
Grouing v :

List of variables: ftems: by |
Cubel Cubel PES
+

Cubed Cubed
Cubed Cubed
Fams1 Add | Fams1
Fams4 Fams4
Walking 1 Walking1
Walking3 Walking3
Applesi Apples
Apples? Apples2

Apples3 :--IIllnq D
Cortinent

Rl —T— Aoy o o groues

The Items tab dialog for a multidimensional IRT analysis is shown below.



F ™

Data File: | C:\IRTPRO Examples'By Dataset\PISA MathBook 1\PISAMathBook 1USUK, ssig J Read File |

Tlad'ftional“ IRT ||Hasch|

| Description ||Group | tems I Madels l| Scoring l| Simulation l
Country

Grouping value: I[G” 1 ;I

List of variables: fteme: > |
Cubel ~ Cube - 4
Cube3 = Cube3 i
Cubed Cubed +
Fams1 Add > | Farms1 =
Fams4 E Farms4
Walking1 Walking1
Walking3 Walking3
Applesi NIJITIbE" of latent Apples
Apples? dimensions: Apples? il
Apples3 — 1 =T r
Continert @2 IG _Ij
4 i 3 Apply to all groups |

Options... oK I Cancel Run

The only difference between this dialog and the corresponding one for a traditional statistics
or unidimensional IRT analysis is the presence of the text box Number of latent dimensions:.
Note that the number of latent dimensions must be specified by the user.

1.6 The Categories tab

When a traditional summed-score statistics analysis is requested via the Analysis option, the
fourth (and last) tab displayed in the corresponding analysis window, is the Categories tab.
The dialog associated with the selection of this tab displays the default item scores
associated with each of the selected items. A user may change these scoring values by
selecting a cell and then right-clicking on the selected cell to display the Recode Item
Scores... option as demonstrated in Section 1.7.1.



F ™

Data File: | C:\IRTPRO Examples\By Dataset\PISA MathBook 1\PISAMathBook 1USLK. ssig J Read File |

Traditional | IRT | Raschl TRT |

|Desc:'iption||Group || ftems | Categories |
Country
Grouping value: [G1]1 -
ltem List Cﬂeguries|DdaCud&s|lenSmr&s| ﬂ
2 0.1 0.1
Cube3 2 0.1 0.1
Cubed 2 0.1 0.1
Fams1 2 0.1 0.1
Fams4 2 01 0.1
| Walkingl 2 0.1 0.1
I Walking3 4 0,123 0123
Apples 2 0,1 D1 v|
H to all
| Read paramater values. . a Ll LT
H
i
|

Options... oK I Cancel Run

1.7 The Models tab

When a unidimensional IRT or multidimensional IRT analysis is requested via the Analysis
option, the fourth tab displayed in the corresponding analysis window is the Models tab. The
dialog associated with selection of this tab displays the default models associated with the
items and allow a user to change the model type and scoring values of the items.

The dialogs for unidimensional and multidimensional IRT differ somewhat in functionality.
These differences will be briefly discussed in Sections 1.7.1 and 1.7.2.

1.7.1 The Models tab, Unidimensional IRT Analysis

The Models dialog displays, for each group, five columns of information, namely an item
list, the number of categories (distinct values) for each item, the data codes (values)
extracted from the IRTPRO dataset, the item scores (coded as 0, 1, 2,... where 0 corresponds
to the smallest data code value, etc.), and the model selected. For an item with two
categories, the default model is the 2PL model and for an item with more than two
categories, the default is the Graded model.



F ™

Data File: | C:\IRTPRO Examples'By Dataset\PISA MathBook 1\PISAMathBook 1USUK, ssig J Read File |

Tradtional || IRT | Rasch | TRT |

| Description ||Group || ftems | Models 'Sconng ||Sin1u|atior1|

Country
Grouping value: I[G” 1 ;I
ltem List | Categories |Data Codes | ltem Scores|  Model | i’
Apples 2 0.1 0.1 2PL
T | Applesz 2 0.1 0.1 2PL
T | Apples3 3 0.1.2 0.1.2 Graded
" |contiret 3 0.1.2 0.1.2 Graded
T Grow? 2 0,1 0.1 2PL
| Growa 2 0,1 01 2PL
| Grow2 3 0,12 0,12
Constraints... | DIF... | Apply to all groups |

Options... oK I Cancel Run

Item scores can be user-recoded. To do so, select a cell listing the scores to be changed. By
right-clicking on the selected cell, the Recode Item Scores... option is displayed.

Ttem List | CategoriesData Codesitem Score! Model | -
Cubel 2 0,1 0,1 2PL =
| cubes 2 0,1 0,1 2PL
| cube4 2 0,1 0,1 2PL
 Farmst 2 0,1 0,1 2PL
 Farmst 2 0,1 0,1 2PL
~ |walkingt 2 0,1 0,1 2PL
Walking3 4 0,123 m Recode [tem Scores... '
Apples1 2 0,1 0,1
© |applesz2 2 0,1 0,1 2PL
~ |appless 3 0,12 0,12 GP Credit <
Constraints... " DIF... |E Read parameter values... i Apply to all groups

Selection of this option opens, for each of the groups, an Item's Codes and Scores dialog. By
double-clicking on an Item Score: cell, the relevant cell may be edited and a new value
entered. The screenshots below show the recoding of the scores for the item Walking3 from
(0,1,2,3)to (0, 1, 1, 2).



Double-click on row Edit number and click OK

Item's Codes and Scores ﬂ Item's Codes and Scores ﬁ
i —
Item: Walking3 Trem: Walking3
Data Codes Item Scores oK Data Codes Item Scores OK
] ] 0 0
Cancel
| . . ; | : |
2 2 2 1
: |
1 < 11 | »

1

The user may also change the default model type. This is accomplished by selecting cell(s)
that display a similar model type that needs to be changed. Right-click on any of the selected
cells to display a drop-down list of available models and make a selection. See Section
Error! Reference source not found. for an example that illustrates this function.

| Description [||Group [|| ttems | Modsls lScm‘ing "|Simulatinn"

Country
Grouping value: |[G'I] i ﬂ
ltem List = Categories | Data Codes | tem Scores|  Model j
Applest 2 0.1 0.1 2FL
Apples? 2 0.1 0.1 2PL
Apples3 3 0.1.2 0.1.2
Cortinent 3 0.1.2 0.1.2
Grow1 2 0.1 0.1 2PL
Grow3 2 0.1 0.1 2PL
Grow?2 3 0.1,2 0.1.2 2pL
Constraints. . | DIF.. | £ L
— Graded
GPCredit
Maminal

At the bottom left of the Models dialog there are two buttons, labeled Constraints... and DIF...
respectively. The latter button gives access to a dialog for entering parameter values or
reading them from a file. Typically, these values are used to score a set of items that were
previously calibrated.

By clicking on the Constraints... button an Item Parameter Constraints window is invoked.
Use of this window allows the user to fix or free parameters or to set selected parameters



equal.

| |
Group: Country
| Group, Item | -
G2, Cubes a 37 |c 38
G2, Farmsl a 39 |[c 40
G2, Farms4 a 41 | ¢ 42
G2, Walkingl |a 43 |c 44
G2, Walking3 | a 45 |c1 (] c3 o4
Trend ~ |71  46(42 47|43 48
G2, Applesl | a 49 |c 50
G2, Apples2 | a 51 ¢ 52
G2, Apples3 | a 53 |cl c2 c3
Trend ~ |l 54{42 55 L
G2, Continent | a 56 | €l €2 o]
Trend = |7l 57( 42 58
G2, Growl a 3 |c 60
G2, Grow3 a 61 |c 62
G2, Grow2 a 63 [cl c2 o] =
Trend = |7l 6442 63
G1, Means
G1, Cov
G2, Means ul 66
G2, Cov cll 67 .

Set parameters equal across groups

The DIF button (differential item functioning) is enabled when the analysis is to be
performed for multiple groups.



(") Test all items, anchor all items.

) Test candidate items, randomized groups:

(@)Test candidate items, estimate group difference with anchor items:

List of variables: Candidate

Cubel
Cube3

Cube4
Y Add ==
Farmsl

Farms4
Walking1
walking3
Applesi Anchor
Apples2
Apples3
Continent

Growl
Grow3
4 1

Group contrasts...

1.7.2 The Models tab, Multidimensional IRT Analysis

The Models tab for a multidimensional analysis has exactly the same functionality than that
described in the previous section for the unidimensional case, except that the buttons below
the Multidimensional Analysis window are labeled Constraints..., EFA..., and Bifactor...,
where EFA denotes exploratory factor analysis and Bifactor denotes a bifactor analysis.



F ™
-

Data File: | C:\IRTPRO Examples'By Dataset\PISA MathBook 1\PISAMathBook 1USUK, ssig J Read File |

Tradtional || IRT ||Rassh| TRT |

| Description ||Group || ftems | Models 'Sconng ||Sin1u|atior1|
Country
Grouing vale: -
ltem List | Categories |Data Codes | ltem Scores|  Model | i’
2 0.1 01 2FL
Cube3 2 0.1 01 2FL
T | Cubed 2 0.1 01 2FL
" | Famst 2 0.1 01 2FL
| Fams4 2 0.1 0.1 2PL
| walking 2 0.1 0.1 2PL
" |wakingz 4 01,23 01,23 Graded
| Applest 2 0.1 0.1 2PL v|
Constraints... | EFA.. | Bifactor... Apply to all groups

Options... oK Cancel Run

Clicking the EFA... button activates the Exploratory Factor Analysis dialog shown below. To
verify that the user intends to specify EFA, the Exploratory item factor analysis box is
checked. Additionally, a selection of one of the four available rotation methods can be made.

The reader should note that once the EFA... option is selected, the Constraints... option is no
longer available, since IRTPRO automatically sets up the constraints in this case.

Exploratory Factor Anm n

Exploratory item factor analysis

[/ Treat item responses as ordered

Rotation

(") Oblique CF-Quartimax

(") Orthogonal CF-Varimax

(") Oblique CF-Varimax




The Bifactor... option provides access to the Bifactor Analysis dialog that allows the user to
select items associated with specific factors.

(T
=l

Country

Grouping value: I[Gl] 1

7

EEDDDDDDD*E

00 XM OO0 w

JOOOoO0oOoooge

Walking 1
Walking3

1000000000 «

2
X
X
X
|
Farms4 [l
|
|
|
|
=

¥

1.8 The Scoring tab

When a unidimensional IRT or multidimensional IRT analysis is requested via the Analysis
option, the second last tab displayed in the corresponding analysis window is the Scoring
tab.



- -
Unidimensicnal Analysis

] I
Data File: | C:\IRTPRO Examples\By Dataset\PISA MathBook 1\FISAMathBook 1SUK. ssig J Read file |

Traditional || IRT | Rasch | TRT |

| Description I|Group || ftems ||Modal5| Scoring ISi.rnulationl

Compute response pattem
[ Person ID:
= I LI v [~ MAP scores
[~ Create summed-score to scale conversion table ¥ Score persons
—Scaling

™ Integer scores Mean: In Standard deviation: |1
[~ Minimum: I [~ Maximum: I

Scalein: ' Population distribution
" Sample distribution

Options... OK I Cancel Run

1.9 The Simulation tab

When a unidimensional IRT, or multidimensional IRT analysis is requested via the Analysis
option, the last tab displayed in the corresponding analysis window, is the Simulation tab.



' ™

Data File: | C:\IRTPRO Examples'By Dataset\PISA MathBook 1\PISAMathBook 1USUK, ssig J Read File |

Tradtional IRT | Rasch || TRT |

| Description ||Group l| ftems || Models||5coring| Simulation

v Simulation
Group: Country Examinees
[G1]1 358
G2 2 889

Mumber of replicate datasets: |5 Percentage missing values: Ig

Random number generator's seed for:

Latent variable deviates: Iqag‘,.-‘ New seed |
Creating item responses: ITI"'SB1 New seed |

Options... 0K I Cancel Run

1.10 Advanced options window

The Advanced options window can be accessed using the Analysis, Advanced Options...
selection via the main menu bar, or alternatively, by clicking the Options... button (lower
right-hand corner of an Analysis window).

. IRTPRO - [PISAMathBc
[0 File Edit Data Manipulate Graphics [Analysis| View Window Help
DeH +tB2R2| &7 | Traditional Summed-Score Statistics...
Cubel | Cube3 | Cubet | Unidimensional IRT...
1o o o o Multidimensional IRT..
2 | 1 1 0 )
T I I o o IRT Scoring...
| 4 :1 :U :1 Advanced Options...
5 | L L 11'¢ | Show Progress Box
| £ |1 1 0 0

This window currently has five active tabs, these being Estimation, Starting Values, Priors,
Miscellaneous, and Save. The estimation window is shown below and makes provision for
three estimation methods:

o Bock-Aitkin

o Adaptive quadrature

o MH-RM



i Test: IIF‘.T ;l Apply to all tests | i

Estimation IStarting ‘u'a]u&s“ Priors || I\J'I.iscel.laneous“ Save l

Estimation method: | g ck-Aitkin

Adaptive Quadrature ‘
—Converge informati MH-RM =

Maximum number of cydes: I 500 _IZ' Convergence criterion: | 1s-005

M-Step maximum iterations: | gg _I Convergence criterion: I 1e-006

—Quadrature details

MNumber of points: Iq.g _l: Maximum value: IG

Apply dimension reduction

Standard errors:  [5_gm |
I Group Gen Dim
Gl 1
G2 1

Default |

oK I Cancel Apply

The Miscellaneous dialog is used to control printout of results, and the number of processors
to be used.



Advanced Opti
e
|| Test IIF‘.T ;l Apply to all tests |

| Estimation ||Startir1g ‘u"alue.5|| Priors | Miscellaneous ISa\te l

Mumber of decimal places in tabular listings: m

Mumber of processors: x
2] 2 =

[ Print table of standardized residuals
¥ Compute Chen-Thissen LD and item fit statistics

[~ Compute limited-information overall model fit statistics

[ Print each tem's goodness of fit frequency table

Minimum expected value: |1

¥ Print parameter numbers
v Print diagnostic information

™ Print dump file ™ Frint full dump file

oK I Cancel Apply

The Save dialog is used to request the print-out of results to specific files.



Test T | Applytoal testsl

| Estimation ||Starting ‘u"aluesl| Priors ||Mi5cellaneous| Save I

Item parameter estimates (-prm.td)

] Asymptotic covariance matrix of the parameter estimates (-cov.bed)
ID Infermation values, for unid isional models only (-inf.bd)

[ Inter-item polychoric correl s, for EFA maodels anly (-pol.td)
Factor loadings (-fac.bd)

1.11 The Data menu

The Data option (main menu bar) enables one to insert or delete variables and/or cases from
the IRTPRO data file that is currently open. In addition, the drop-down menu makes
provision for the renaming of variables (Variable Properties... option) and for entering a
missing value code.

E IRTPRO - [PISAMathBook1USUK.ssig]

[ File Edit [Data| Manipulate Graphics Analysis View Window Help
=y = Insert Variables...

Cube Delete Variables... | Famst | ‘wakingl |
Insert Cases...

Delete Cases...

Variable Properties...
Missing Value Code...

Bt I N o I R PRI L )
e S
- oo - oo o

Recalculate Item Counts

1.11.1 The Variable Properties... Option

The Properties dialog displays the distinct values (data codes) for each item, together with
the frequency counts.



S

Hame: ’Cube]

Type: [Fixed point Type: [Discrete

Description:

Values

Count Label
411
836

Variables may be renamed. A description of each item may be entered along with descriptive
names for corresponding to the numeric values. For example 0 = Experimental, 1 = Control.

Hame: |Group v] R

Type: [Fixed point Type: [Discrete

Description: Defines the control and experimental groups

Label

Control
Experimental

1.11.2 The Missing Value Code... Option

The Missing Value Code... option allows one to assign a missing value code by entering the
appropriate value in the Missing Value text box. The value entered is accepted if the OK



button is clicked. In this case, the user must use the File, Save option to ensure that this
change to the dataset definitions is permanent. The default missing value code is -1.

Missing Value Code . » u
Missing value o] m

Cancel

1.12 The Data Manipulation window

This window makes provision for the recoding of variables. Suppose, for example, that the
variable Group is coded 0, 3 and 4 and that we want to recode these values so that 0 = 1; 3
and 4 = 2. This recoding is accomplished by clicking the if...else...endif button. Variable
names can be entered by double-clicking on a variable name, or dragging it to the
appropriate position in the recode window. The last statement shows the recoding of the
variable Score to Score = exp(Score).

Variables: +|x F:';j;’"sz [ foendii | [ foelse.enaf |

gt Exp() )=l =)=

= |,

oo SqrtQ)
a)zfa))
Lo L =00

if { Group == 0) then
i Group =10

else

Group = 2

endif

Score = Exp( Score)

OK ] ’ Cancel
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